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COMP-162 COMPUTER APPLICATIONS 

CHAPTER 2 
 

              SHORT QUESTIONS 
 

Q1: Define Windows operating system. 

Microsoft Windows is a graphical operating system developed and by Microsoft. It provides a 

way to store files, run software, play games, watch videos, and connect to the Internet. 

کرنے،   سٹورفائلوں کو  ہیہے۔  ایک  ارینے ت کمپنی کروسافٹیسسٹم ہے جو مائ ٹنگیآپر کلی گراف کیونڈوز ا کروسافٹی مائ

فراہم کرتا ہے۔  قہی طرکا   نےمنسلک ہوسے   ٹی اور انٹرن کھنےید وزیڈیو لنے،یکھ  میچلانے، گ ئریسافٹ و   
Q2: What is GUI? 

Graphical user interface (GUI), a computer program that enables a person to communicate with a 

computer through the use of symbols. 

  (GUI)   سی انٹرف وزری کلیگراف  

کرنے کے قابل    تیسے بات چ وٹریکمپ   عےی شخص کو علامتوں کے استعمال کے ذر یجو کس ہے پروگرام وٹریکمپ کیا

  بناتا ہے۔

Q3: What is folder? 

A folder is a way to organize computer files. A folder is a storage space, or container, where 

many files can be placed. 

  یجہاں بہت س ہے ہوتا نریکنٹ  ای جگہ یکرنے ک  سٹور کیہے۔ فولڈر ا قہیطر  کیفائلوں کو منظم کرنے کا ا وٹریفولڈر کمپ

۔ںیہ  یجا سکت یرکھ ںیفائل  

Q4: What is an icon? 

An icon is a small graphical representation of a program or file. When you click or double-click 

an icon, the associated file or program opens. 

  ای کلکپر   کنیآئ یہے۔ جب آپ کسکرتی   ینمائندگ یفائل ک ایپروگرام  کسی  ہوتی ہے جور یتصو سی یچھوٹ ایک کنیآئ

پروگرام کھل جاتا ہے۔  ایائل علقہ فتو مت ںیکلک کرتے ہڈبل   

Q5: For which purpose, recycle bin is used. 

The Recycle Bin is used to store deleted items. It temporarily stores files and folders before they 

are permanently deleted. 

فائلوں اور فولڈرز کو مستقل طور پر   ہیہے۔  ہوتی استعمال ےیکرنے کے ل سٹورکو  اءیشا یگئکی   ڈیلیٹ بن کلیسایر

ہے۔  یسٹور کرتطور پر  یکرنے سے پہلے عارض ڈیلیٹ  

Q6: For which purpose, file explorer is used in windows 10. 

 It is used to browse folders and files. 

استعمال ہوتا ہے۔ ےیکے لکرنے  زؤفولڈرز اور فائلوں کو برا ہی   
Q7: For which purpose, control panel is used. 

It is used to view and change hardware or software settings. 

استعمال ہوتا ہے۔  ےیکرنے کے ل لیتبد  یا کھنےی کو د سیٹنگ یک ئری سافٹ و ای  ئریہارڈ و ہی    
Q8: What is meant by shortcut? 

A Windows shortcut is an icon that points to a program or data file. 

طرف اشارہ کرتا ہے۔  یفائل ک ٹایڈ ایپروگرام  یہے جو کس کنی آئ کیونڈوز شارٹ کٹ ا   

Q9: What is desktop screen? 

The desktop is the main screen area that you see after you turn on your computer. It is where the 

icons for the files and folders is displayed. 

وہ جگہ ہے   ہی ۔ کہلاتا ہے  ٹاپ کسیڈ حصہ یمرکز  والا  ےآننظر  پر نیاسکر وٹریکمپ   ، کو آن کرنے کے بعد  وٹریکمپ 

۔ںیہ  ےظاہر ہوت کنیآئ ےجہاں فائلوں اور فولڈرز ک  
 
 

Q10: What is notification area, what it displays? 

The notification area is a part of the taskbar that displays the programs running in the 

background, notifications and status. 
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  متعلقہکے   ٹسیاطلاعات اور اسٹپروگرام،  چلنے والے ںیپس منظر م  ہاںحصہ ہے ج کی ٹاسک بار کا ا ایریا شنیفکی نوٹ

  ہے۔ ہوتیہر ظا یشنفارمان
 
Q11: What is meant by system loading? 

System loading means moving the necessary files from a drive (e.g., hard drive), into a 

computer's memory (RAM). 
ہے۔ منتقل کرنا ںی م    (RAM)  یموری م یک وٹری ( سے کمپ وی ائ ڈر ہارڈ سےی )ج وی فائلوں کو ڈرائ  یضرور سسٹم لوڈنگ کا مطلب   

 
Q12: Write method of creating new folder in Windows 10. 

1. Navigate to the location where you want to place the new folder. 

2. Right-click and select New. 

3. Select Folder. 

4. The folder will be displayed, with the default name "New folder." 

۔ںیچاہتے ہ  بنانافولڈر  ایجہاں آپ ن ںیائج اس مقام پر  .1 

۔ںیمنتخب کر  New اور ںیکلک کر  ٹنب ںایدائ    .2  

۔ںیفولڈر منتخب کر   .3 

”New folder“  گا۔ جائے کے ساتھ ظاہر ہو نام فالٹیفولڈر ڈ ۔ 4  

  
 
Q13: Define screen resolution. 

A term that refers to the number of pixels on a display screen. A higher resolution means more 

pixels and more pixels provide greater quality. 

  ادہیپکسلز اور ز ادہیکا مطلب ہے ز وشنیزولیر ادہیہے۔ ز کہلاتی زولوشنیر نیاسکرتعداد  یپر پکسلز ک نیاسکر ڈسپلے

۔ یکوالٹ  ہترب مطلبکا  پکسلز  
 
Q14: Why screen saver is used? 

 It is used as a security to hide desktop contents while the user is away from computer. 
 

جب یوزر کمپی وٹر سے دور ہوتا ہے تو اسے ڈیسک ٹاپ کے مواد کو چھپانے کے لی ے سی ک یورٹی کے طور پر استعمال  

 کیا جاتا ہے۔
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CHAPTER 3 

M i c r o s o f t  W o r d 
Short Questions 

 

1. Define the Microsoft Office. 
 

MS. Office is one of the most popular application software. It is a complete office suite with 

various software programs like MS Word, MS Excel, MS Power Point etc. It provides different 

functions which are normally used in Office working. 

   ئریسافٹ و  مختلف  ںیمکمل آفس سوٹ ہے جس م کیا ہی ہے۔   ئریسافٹ و شنی ک یپلیا نیمقبول تر کیآفس ا کروسافٹی مائ

MS Word ،MS Excel ،MS Power Point ۔ہوتے ہیں  رہیوغ      سےیج پروگرامز 

۔ںیاستعمال ہوتے ہ ںیپر آفس ورکنگ م ختلف فنکشن فراہم کرتا ہے۔ جو عام طوریہ م  
 
2.Enlist some MS office applications 
 

Microsoft Word 
 
Microsoft Access 
 
Microsoft Excel 
 
Microsoft PowerPoint 
 
Microsoft OneNote 

  
                        Microsoft Outlook 
 
3.Define the Word processor. 
 

A word processor is application software that performs various tasks like formatting text, 

printing text, page setup, composing document etc. 

  ڈاکومنٹس اپ،  ٹیس جیپ ، پرنٹنگ  کی  کسٹی ٹ ٹنگ،یفارم یک ٹیکسٹہے جو  ئریسافٹ و  شنیک یپلی ا کیا سریورڈ پروس

ہے۔  تایمختلف کام انجام د  سےیج  رہیوغ  ،کمپوزنگ کی  
 

4.Enlist some well-liked word processors. 
 

 Microsoft Word 
 

 Word Pro 
 

 Word Perfect 
 

 Word Star 
 
5.Define the Microsoft Word. 
 

Microsoft Word is one of the most popular software programs in the world, used by millions of 

the people around the world. There are various features to create, read and edit documents. 

لوگبھر کے لاکھوں  ایجسے دن ہے کی سے ا ںیپروگراموں م ئری سافٹ و نیکے مقبول تر ایدن   Microsoft Word  

  یجات یپائ اتیمختلف خصوص  ےیکرنے کے ل میترم  ان میں  بنانے، پڑھنے اور اس میں ڈاکومنٹس  ۔ںیاستعمال کرتے ہ 

۔ںیہ  
 
6. What is the File Menu? 
 

The File Menu contained commonly known commands related to file such as New, Open, Save, 

Close, Print and Recent Documents. 

کہ ا سیج ںیہ  یکمانڈز ہوت شہورمفائل سے متعلق عام  ںیم  نویفائل م  

New, Open, Save, Close, Print and Recent Documents. 

7. Define the Ribbon of MS Word? 
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A ribbon is a command bar that organizes a program's features into a series of tabs at the top of a 

window. The Ribbon makes it easier to see and find commands to format your document. 

  بیترت  ںیم  زیریس کیا یک بزی ٹ ںیحصے م یکو ونڈو کے اوپر اتیخصوص یپروگرام ک یکمانڈ بار ہے جو کس  کیربن ا

ہے۔   ہو گیااور تلاش کرنا آسان  کھنایکمانڈز کو د ےی کرنے کے ل ٹی کو فارم  ٹس نمو کوجہ سے ڈا یکربن  ہے۔ تاید  
 
8. Define the Quick Access Toolbar of MS Word? 
 

The Quick Access Toolbar is located in the top-left corner of an Office application. By default, 

the Quick Access Toolbar displays the Save, Undo, and Repeat commands. 

پر بار ٹول اکسس کی کوئ   ڈیفالٹ یئ  اب ۔ہے ہوتی موجود  کونے ںیبائ  یکے اوپر شنیک یپل یآفس ا ٹول بار کسسیا کی کوئ    

اور  Repeat  ہیں۔کمانڈز ہوتی کی  Undo ، Save   
 

9. Define the Title bar? 
 

The title bar is horizontal bar at the top of an active document. This bar displays the name of the 

document and application program. 

نام  پروگرام کا ورڈاکومنٹ کا نام ابار  ہیہے۔  ہوتیبار یافق ںیحصے م والےکے اوپر ٹکھلے ہوے ڈاکومنٹائٹل بار 

ہے۔  یدکھات  
 

10. Define the document area. 
 

The white space framed between rulers and the scroll bars looking like a blank sheet of paper. 

This is the area where you type the text of the document. 

  جگہوہ  ہیہے۔   ہوتی جگہ دی سف دینے والی یدکھائطرح  یک ٹیش یخال یکاغذ ک انیکے درم بارزاور اسکرول رز رولیہ  

۔ ںیٹائپ کرتے ہ کسٹٹیکا   ٹنموکاڈ ہے جہاں آپ  
 

11. Define the cursor. 
 

The blinking vertical line in the document area is called cursor or insertion point. The typed 

characters appear at its location. 

  کرتےہیں ٹائپ جو ہم  حروف وہہے۔ ا اتج ہاانسرشن پوائنٹ ک  ایلائن کو کرسر  یعمود یوال  ےجھپکن ںیمڈاکومنٹ ایریا  

۔ںیمقام پر ظاہر ہوتے ہ  یاس  
 

12. Define the ruler. 
 

The ruler is a measurement tool used with MS Word that allows the program's user to align 

graphics, text, tables, or other elements on a page. 

صفحہ پر گرافکس،  یکو کس یوزرجو پروگرام کے  ٹول ہے  یمائشیپ  کیا نے والاہو ل امعتسا میں ورڈ سیا میا ،رولر

ہے۔ے لیے استعمال ہوتا لانے ک  ںیم دھیعناصر کو س گری د ایٹیبل  ، ٹیکسٹ  
 

13. Define the scroll bar. 
 

Scrollbar is used to display different portions of a document in the document windows. There are 

two types of scrollbars, horizontal scrollbar and vertical scrollbar. 

ہے۔ اسکرول   یجات یاستعمال ک ےیکے مختلف حصوں کو دکھانے کے ل  ڈاکومنٹ  یکس ںی م  ڈاکومنٹ ونڈو ،ارباسکرول 

۔ اسکرول بار یاور عمود اسکرول بار یافق ں،یہ  ںیدو قسم یبار ک  

14. Define the window control buttons. 
 

These are three buttons that provide quick and basic functions for manipulating each  Window 

currently visible. The first "dash" button will minimize the window. The middle button will 

cause the window maximize or will return the window to its original size. The last "X" button 

will close the window. 
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۔ ںیفراہم کرتے ہ زنکشنف یادیاور بن  یفور ےیکے ل ےسلجھانکو  ونڈو ینظر آنے وال موجودہ  ہر یں جوہوتے ہ بٹن نیت ہی

دے واپس  ںیونڈو کو اس کے اصل سائز م ایگا ے کر بڑھابٹن ونڈو کو   یانیے گا۔ درمکر  چھوٹا" بٹن ونڈو کو شیپہلا "ڈ

گا۔کو بند کر دے  ونڈو  "X" بٹن یآخر ہے گاجبک کر     
 
15. Define the zoom slider. 
 

The buttons that magnify or reduces the contents in the document window. 

۔ ںیکرتے ہ چھوٹا ای  موجود مواد کو بڑھا ںیونڈو م   ڈاکومنٹوہ بٹن جو   
 

16. What is shortcut key to access File Menu? 
 

Alt + F is the keyboard shortcut to access the File Menu. 

ہے۔  Alt + F    بورڈ شارٹ کٹ  یک ےیکے ل کو ایکسس کرنے نوی فائل م
 

17. What command is used to create new file in MS Word? 
 

Click on File Menu >> NEW, OR use the shortcut Ctrl+N 

۔ںیاستعمال کر شارٹ کٹ  Ctrl+N   یا ۔ںیپر کلک کر   File Menu >> NEW 
 

18. What is keyboard shortcut to create new file? 
 

Ctrl + N is keyboard shortcut to create new file. 

۔ہے   Ctrl + N بورڈ شارٹ کٹ    یک ےیفائل بنانے کے ل ینئ  

 

19. Which file template is mostly used when new word file is created? 
 

The Blank Document template is mostly used when new word file is created. 

Blank Document ۔ہے یاستعمال ہوت ٹیمپلیٹ    تر  ادہیز نے کےلیےورڈ فائل بنا ینئ
 

20. Why documents are necessary to save? 
 

If you want to use documents in future, it is necessary to save them. 

ہے۔  یمحفوظ کرنا ضرور ںی تو انہ ،ںیاستعمال کرنا چاہتے ہ ٹسومنکڈا ںیاگر آپ مستقبل م  
 

21. Which command is used to save a word file? 
 

Click on File Menu >> SAVE, OR use the shortcut Ctrl+S 

۔ںیشارٹ کٹ استعمال کر  Ctrl+S  ای ۔ںیپر کلک کر    File Menu >> SAVE 

22.What is difference between SAVE and SAVE As command? 
 
The Save command is normally used to save a document for the first time or to save changes. On 

the other hand, Save As command is used to save a previously saved document with different 

name. 

۔جاتا ہے ای ک ےی کو محفوظ کرنے کے ل وںی ل ی تبد ای  ےبار محفوظ کرن  یکو پہل کومنٹاڈ یکمانڈ کا استعمال عام طور پر کس    Save   

Save As جاتا ہے۔ ای ک ےی کو مختلف نام کے ساتھ محفوظ کرنے کے ل ڈاکومنٹا استعمال پہلے سے محفوظ کردہ کمانڈ ک  ہ جبک     
 
23. What is procedure to save file in MS Word? 
 

To save a document follow one of these methods: 
 

Press Ctrl + S from keyboard. 
 

      OR 
 

Press Alt + F to open File menu then select Save or Save As command. 
 

OR 
 

Click the Save icon on the Quick Access Toolbar. 
 

A dialog box will appear, in which select location where you want to save, then type name of 

document and Click on SAVE button. 
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: ںیپر عمل کر کیا یسے کس ںیم  قوںیان طر ےیکرنے کے ل  کو محفوظ ڈاکومنٹ یکس  

 

۔ںیدبائ  بورڈ سے یک  Ctrl + S 

ا ی  

خب کریں۔کمانڈ کو منت  Save As    یا Save پھر  ںیدبائ   Alt + F ںیکر ےی کو کھولنے کے ل نویم فائل    

ا ی  

۔ ںیپر کلک کر کنیآئ سیوو پر ٹول بار کسسیا کی کوئ  

   کا نام  ڈاکومنٹپھر  ں،یجہاں آپ محفوظ کرنا چاہتے ہ ںیوہ مقام منتخب کر  ںیہے، جس م  گاہر ہوس ظااکب گلایڈائ کیا

  کریں ٹائپ اورSAVE   ۔ںیبٹن پر کلک کر
 

24. Which command is used to open an existing word file? 
 

Click on File Menu >> Open, OR use the shortcut Ctrl+O 

۔ںیل کراتعماس شارٹ کٹ  Ctrl+O  ای ۔ںیپر کلک کر     File Menu >> Open 
  

26. What is the procedure to open your word files? 
 

To open already existing document, follow one of these methods: 
 

Press Ctrl + O from keyboard. 
 

OR 
 

Press Alt + F to open File menu then select Open command. 
 

OR 
 

Click the Open icon on the Quick Access Toolbar. 
 

A dialog box will appear, in which select location where your document exists, then select name 

of document and Click on OPEN button. 

: ںیپر عمل کر کیا سے ںیم  قوںیان طر ے،یکو کھولنے کے ل  ڈاکومنٹپہلے سے موجود   

۔ںیدبائ  بورڈ سے یک  Ctrl + O 

ا ی  

Open خب کریں۔کمانڈ کو منت  پھر  ںیدبائ    Alt + F ںیکر ےی کو کھولنے کے ل نوی م فائل   

ا ی  

۔ںیپر کلک کر کنیآئ اوپن پر ٹول بار کسسیا کی کوئ  
 

کا نام    ڈاکومنٹپھر  ،ےہ جودومکومنٹ  کا ڈا جہاں آپ  ںیوہ مقام منتخب کر  ںیہے، جس م  گاہر ہوس ظاباک لاگیڈائ کیا

   کریں منتخب اور Open   ۔ںیبٹن پر کلک کر

27. What is text editing? 
 

Editing text means making changes to the tex. Text editing is the ability to change text by 

adding, deleting and rearranging letters, words, sentences and paragraphs. 

شامل کرنے، حذف کرنے   وک راگرافیجملے اور پ ،حروف، الفاظ ۔ہے کرنا اںیلیتبد ںیم ٹیکسٹ کا مطلب نگٹ ایڈ ٹیکسٹ

ہے۔   تا کہلا  نگٹ ٹیکسٹ ایڈکا عمل کرنے  لیکو تبد ٹیکسٹدے کر  بی اور دوبارہ ترت  
 

28. When text selection is needed? 
 

Text selection is normally used for text formatting. 

ہے۔ تیکی جا ےیکے ل  ٹنگیفارم کسٹیعام طور پر ٹ لیکشنٹیکسٹ کی س  
 

29. What is shortcut to select whole document? 
 

Ctrl + A is the shortcut to select whole document. 
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Ctrl + A ہے۔    شارٹ کٹ یکو منتخب کرنے کڈاکومنٹ  ےپور

30. What is the method to select text? 
 

By pressing SHIFT and ARROW keys from keyboard you can select text.     OR  

By dragging the mouse text can be selected by mouse. 

یا  ٹیکسٹ کو منتخب کر سکتے ہیں۔آپ   کیز کو دبانے سے  ARROWاور SHIFT   کی بورڈ سے 

۔جا سکتا ہے ایمنتخب ک عےیکو ماؤس کے ذرٹ کس ٹی (کر ٹی گھس) کر کے ڈریگماؤس کو   
 

31. Which keys are used to erase text character by character? 
 

The BACKSPACE and DELETE keys are used to erase text character by character. 

کا استعمال کیا جا تا ہے۔کیز   BACKSPACE اور DELETE    کے لیے ے مٹانےرف کر کحک ٹیکسٹ کو ایک ای
 

32. Define the clipboard. 
 

A clipboard is a temporary storage for data that the user wants to copy from one place to another. 

When you select the text and then cut or copy that text, it stores in clipboard for further use. 

کرنا  یجگہ کاپ یسے دوسر ہے جسے یوزر ایک جگہ جگہ کی اکی  طورپرسٹورکرنے  یعارضوک  ٹایڈاس  ،ورڈکلپ ب

استعمال کے   دیمز  ہیتو  ں،یکرتے ہ  یکاپ  ایٹ کو ک  کسٹٹی اور پھر اس  ںیکو منتخب کرتے ہ  ٹیکسٹے۔ جب آپ  چاہتا ہ

محفوظ ہوجاتا ہے۔  ںیکلپ بورڈ م  ےیل  
 

33. What is the shortcut key for Cut, copy and paste command?  

CTRL + X is the keyboard shortcut for cut command.  

CTRL + C is the keyboard shortcut for copy command.  

CTRL + V is the keyboard shortcut for paste command. 
 
34.What is the shortcut key for Undo and Redo command? 

 CTRL + Z is the keyboard shortcut for Undo command. 

CTRL + Y is the keyboard shortcut for Redo command. 

35.What is difference between CUT and COPY command? 
 

When we use Cut command, selected data removes from original location. On the other hand, in 

Copy command data remains present in its actual location. 

کمانڈ   یطرف، کاپ یجاتا ہے۔ دوسر ختم ہواصل مقام سے  ٹایڈ یکٹ کیا ہواسیل تو ںیاستعمال کرتے ہ کمانڈ   کٹ جب ہم

   ۔پر موجود رہتا ہے مقام اپنے اصل ٹایڈ ںیم

 

 

 

36. Define the Undo command. 
 

This command undoes previous actions allowing you to recover from mistakes as though they 

never happened. 

۔ںیہوئ ںینہ یوہ کبھ ایگو ںی سکتے ہحاصل کرچھٹکارہ سے  وںیہے جس سے آپ غلط یکرت  عمل کو ختمکمانڈ سابقہ  ہی  
 

37. Define the Redo command. 
 

Redo command is used to revert the effects of the undo command. 

جاتا ہے۔ ایک ےیکے اثرات کو واپس کرنے کے ل  ڈمانڈ کا استعمال انڈو کمانک  Redo  
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40.Define the text formatting in MS Word? 
 

Format means the way a document looks or appears. In Microsoft Word formatting can be 

applied to make the document more presentable and interesting.  

خوبصورت   دیکو مز ڈاکومنٹ ںیورڈ م  کروسافٹیہے۔ مائ  صورتشکل و ی ظاہر  کی ڈاکومنٹکا مطلب  ٹیفارم

جا سکتا ہے۔ ایک  استعمالکا  ٹنگیفارم ےی بنانے کے لرجاذب نظراو  
 

41. What are keyboard shortcuts for bold, italic and underline?  
 Bol             (CTRL+B) 
 Italic   (CTRL+I) 
 Underline   (CTRL + U) 

42. What are keyboard shortcuts for font size to increase and decrease? 
         CTRL + [           to decrease the font size 
          CTRL + ]     to increase the font size        
43. What kind of working can be done during text formatting? 

During the text formatting, you can change font, font style, font color, font size of the text, text 

highlighting using bold, italic and underline etc. 

لک یبولڈ، اٹ  حاوراسی طرکا فونٹ سائز،  کسٹی کے دوران آپ فونٹ، فونٹ اسٹائل، فونٹ کا رنگ، ٹ  ٹنگی فارم کسٹیٹ

۔ںیکر سکتے ہ  لیکو تبد رہی لائٹنگ وغ یہائ کسٹی اور انڈر لائن کا استعمال کرتے ہوئے ٹ  

44. What kind of paragraph alignment can be applied? 

There are four types of paragraph alignment 

۔ںیہ ںیچار قسم یک ئنمنٹ الا راگرافیپ  

 

1. Left Align 3. Center Align 

2. Right Align 4. Justify 

 

45. What are keyboard shortcuts for paragraph alignments? 

 

1. Align Left → CTRL + L 

2. Align Right → CTRL + R 

3. Centered → CTRL + E 

4. Justify  →        CTRL + J 

 

46. Define the Drop Cap. 

 

A drop cap is a large capital letter used as a decorative element at the beginning of a paragraph 

or section. The size of drop cap is usually two or more lines of regular text.  

کے طور پر استعمال ہوتا ہے۔  جز و یآرائش ںیکے شروع م کشنیس  ای راگرافیہے جو پ  ٹریل ٹلیپ یبڑا ک  کیا پیڈراپ ک

ہوتا ہے۔ رابرے بلائنوں ک   ادہیز ایدو  یک  سٹک ٹیکا سائز عام طور پر باقاعدہ  پیڈراپ ک  

47. How the drop cap can be inserted? 

 To apply the drop cap, follow these steps 

o Click inside the paragraph where you want the drop cap to display. 

 

o Select the Insert Tab then select Drop Cap command from Text Group. 

 

o Click the small arrow to open Drop Cap options (None, Dropped and In Margin) 

 

o Click to apply either Dropped or In Margin 

۔ںیان مراحل پر عمل کر ے،ی ے لنے کلگا پیڈراپ ک  

۔ںیڈسپلے کرنا چاہتے ہ  پیجہاں آپ ڈراپ ک ںیکے اندر کلک کر راگرافیپاس  ۔  1 

سے  Drop Cap ۔ںیکمانڈ کو منتخب کر  Text Group پھر ںیکو منتخب کر  Insert Tab .2  
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 (None, Dropped and In Margin)   ںیکر  کلک پر ریچھوٹے ت  ےی کھولنے کے ل پشنزآکے   پیڈراپ ک۔ 3

ںیکلک کر ےی لاگو کرنے کے لکو   Dropped یا In Margin .4 

48.What is the purpose of Change Case? 

Change Case are used to change text case from upper to lower, lower to upper, and everything in 

between. 

اور حروف ڑےب  سے حروف چھوٹے ،وف رح چھوٹے سے حروف ڑےب  کو سیک  کسٹیکا استعمال ٹ    Change Case  

جاتا ہے۔  ایک ےیکرنے کے ل  لیتبد ںیم حرف دوسرے مکس یکئ حطراسی اور  

 

49. What are change case choices in MS Word?  

There are five change case choices  

۔ںیانتخاب ہ پانچ کے  سیک چینج  

1. Sentence Case 

 

2. Lower Case 

 

3. Upper Case 

 

4. Capitalize Each Word 

 

5. Toggle Case 

 

50. Why bullets & numbering are used? 

 

Bullets and Numbering are used to make lists, the numbered lists and the bulleted lists. 

   ۔ںیفہرست یلاو ٹسبلاور  ںیفہرست ی، نمبر والکیا جاتا ہے ےیبنانے کے ل  ںیفہرستبلٹس اور نمبرنگ کا استعمال 

 

51. What is difference between numbered and bulleted lists? 
 

Numbered lists are used to show a sequence of information. A bulleted list might be better if 

there is no priority or sequence among the list items. 

  ای حیترج  یکوئ ںی۔ اگر فہرست کے آئٹمز م ںیہ  یاستعمال ہوت ےیکو دکھانے کے ل  بیتتر یمعلومات ک ںیفہرست ینمبر وال

ہے۔  یفہرست بہتر ہو سکت یوال ٹسبلنہ ہو تو   بیترت  
 

52. Define the Borders & Shading 
 

Borders and shading are always used to decorate a text. The border provides an outer/inner lining 

of different style and color on the selected text/paragraph. Shading is similar to highlighting the 

text/Paragraph.Using Shading, background of selected text can be filled with different color and 

patterns. 

  ختلفم پر راگرافیپ /ٹیکسٹبارڈر منتخب   جاتا ہے۔ ایک ےی لے ک  نےکو سجاکسٹ ٹی  شہیکا استعمال ہم ڈنگیبارڈرز اور ش

  ۔کرنے کے مترادف ہے  اںیکو نما راگرافیپ / کسٹیٹ ،ڈنگ یش ہے۔  لگاتا ںیلائن یاندرون/یرونیب  رنگوں کیاور  سٹائل 

ے۔ ہ کے پس منظر کو مختلف رنگوں اور نمونوں سے بھرا جا سکتا  کسٹی ٹکا استعمال کرتے ہوئے، منتخب   ڈنگیش  
 

53. Define the Spelling and Grammar check feature of MS Word. 
 

Spelling and Grammar check feature is used to find spelling and grammar mistakes, and also 

provide facility to correct them. 

ہے،   یجات یرنے کے لئے استعمال ککش لاکو ت وںیغلط یاور گرامر ک  سپیلنگ تیخصوص یک چیکاور گرامر سپیلنگ 

۔ ہے یفراہم کرت یسہولت بھ یدرست کرنے ک ںیاور انہ  
 

54. How the Spellings and Grammar check feature works? 
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MS Word automatically identifies misspelled words. It also finds grammar errors and underlines 

them as follows. 
 

1. A red underline on spelling errors. 
 
2. A green underline on grammar errors. 
 
3. A blue underline on correctly spelled but misused words. 

ڈھونڈتا ہے اور ان  یبھ اںیغلط یگرامر ک ہیشناخت کرتا ہے۔  یوالے الفاظ ک  سپیلنگخود بخود غلط  ورڈ کروسافٹی مائ

لائن کرتا ہے۔انڈر سے ریقےط لیہ ذکو مندرج  

 

لائن۔سرخ انڈر پر وںیغلط یک املا            .1 

 

لائن۔سبز انڈر  پر وںیغلط یک گرامر  .2 

لائن۔انڈر یلین پرغلط استعمال شدہ الفاظ  کنی ل سپیلنگ حیصح  .3 
 
55.What is shortcut key to access Spelling and Grammar feature? 
 

F7 is the keyboard shortcut to access the Spelling and Grammar feature. 

۔ہے   F7 بورڈ شارٹ کٹ   یک ےیکے ل یتک رسائ تیخصوص یاور گرامر ک  سپیلنگ  
 

56. Differentiate between Header & Footer. 
 

The header is a section (blank space) that appears in the top margin, while the footer is a section 

(blank space) that appears in the bottom margin. 

جگہ( ہے جو   ی)خال کشنی س  کیظاہر ہوتا ہے، جبکہ فوٹر ا ںیرجن مجگہ( ہے جو اوپر کے ما ی)خال کشنی س کیا ڈریہ

ظاہر ہوتا ہے۔ ںیمارجن م  چےین  

57. What is the purpose of using Header & Footer? 
 

Header & Footer generally contains important information such as page numbers, date, time, 

author name, publisher name, chapter name, book name, and document name etc. 

باب کا  وقت، مصنف کا نام، ناشر کا نام،  خ،یصفحہ نمبر، تار  سےیج ںیہ  یعام طور پر اہم معلومات ہوت ںیاور فوٹر م ڈریہ

۔رہیکا نام وغ ڈاکومنٹور نام، کتاب کا نام، ا  
 

58. How to insert a table? 
 

Following steps are used to insert a table: 
 

1. Click on Insert Tab, then click the Table button 
 

2. Drag your mouse across the white boxes. 
 

3. The top bar will tell you how many rows and columns you are creating. 
 

4. Click the mouse when you have reached your desired size. 

۔ںیجاتے ہ ےیاقدامات استعمال ک لیدرج ذ ےیداخل کرنے کے ل  بلیٹ   

۔ںیپر کلک کر  بٹن    Table  Insert Tab .1   پھر ںیپر کلک کر 

۔ ڈریگ کریںخانوں پر دیو سف اپنے ماؤس ک        .2 

۔ںیاور کالم بنا رہے ہ ںیقطار یکہ آپ کتن یبار آپ کو بتائے گ ٹاپ ۔3   

۔ںیتو ماؤس پر کلک کر ںیجب آپ اپنے مطلوبہ سائز تک پہنچ جائ                .4 

59.How to insert page numbers in a document?  

Procedure: 
 

• On the Insert tab, in the Header & Footer group, click Page Number. 
 

• Click Top of Page, Bottom of Page, or Page Margins, depending on where you    

want page numbers to appear in your document. 
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• Choose a page number design from the gallery of designs. 

: کار قہیرط  

۔ںیرپر کلک ک   Page Number Header & Foot ںیگروپ م   Insert tab .1  پر 

اب سےحسے اس ک  ںیکرنا چاہتے ہ ہاں ظاہریصفحہ نمبر  ںیماکومنٹ  ڈ     .2 

Page Margins پر کلک کریں۔ یا    Bottom of Page  ،Top of Page 

۔ںیمنتخب کر  زائنیے صفحہ نمبر کا ڈس یلریگ یک زائنیڈ    .3 
 
60.How to add symbols in a document? 
 

1.Click in document area where you want to insert the symbol. 
 

2.On the Insert tab, in the Symbols group, click Symbol. 
 

3.Click the symbol that you want in the drop-down list. 

۔ںیجہاں آپ علامت داخل کرنا چاہتے ہ ںیکلک کر  ایریا میں اس جگہ ڈاکومنٹ .1 

پر کلک کریں۔   Symbol  میں Symbols group  پر Insert tab.2 

 3.    پنے مطلب کی علامت پر کلک کریں۔ا ںیڈراپ ڈاؤن فہرست م      
 

61. Define the text box. 
 

Text box is a block of text in your document that can place anywhere in the document. 

۔ ےہ اسکت ا جارکھ یھب ںیکہ  ںیم  منٹڈاکوجو  ےہ  اہوت وہ بلاک اک ٹیکسٹ ںیم ڈاکومنٹ  کسا ب کسٹیٹ  
 

62. How to insert text box? 

Procedure: 
 

1.   On the Insert tab, in the Text group, click Text Box then click Draw Text Box. 
 

2. Click in the document, and then drag to draw the text box. 
 

3. To add text to a text box, click inside the text box and then type the text. 

: کار قہیطر  

پر کلک کریں پھر  Draw Text Box پر کلک کریں۔ Text Box  سے میں Text group پر     Insert tab .1 

 

 2. ڈریگ کریں۔ےیکے ل  کو بنانےاکس  ب  کسٹی اور پھر ٹ ں،یلک کر ک ںیم  ڈاکومنت    

 

۔ںیٹائپ کر سٹک یاور پھر ٹ ںیباکس کے اندر کلک کر   ٹسک ی ٹ  ،ےیشامل کرنے کے ل  کسٹیٹ  ںیم  کسبا  کسٹیٹ ۔ 3 
 
63.Define the page setup. 
 

Page setup is used to set the size and layout of the page. It includes paper size, margins, page 

orientation, etc. 

سائز،  کا   صفحہ ںیہے۔ اس م  استعمال ہوتا ےی کے ل نےی د  بیترت وضع قطع کی حہصف اور اپ صفحہ کا سائز ٹیسپیج 

شامل ہے۔غیرہ و رخ کا صفحہمارجن،   
 

64. What are the margins in page setup? 
 

Margin are the white space that separate text or other elements from the edge of the paper. MS 

Word sets default margins for new documents, but you can change them to fit your document 

requirements. 

ہے۔ یعناصر کو کاغذ کے کنارے سے الگ کرت  گری د ای کسٹی ٹہے جو  ہوتی جگہ دیمارجن وہ سف  

 MS Word  کے مطابق  تضرور یک  ڈاکومنٹ ےآپ اپن کنیکرتا ہے، ل ٹیمارجن س فالٹ یڈ  ےیل کے  ڈاکومنٹس ےنئ 

۔ںیسکتے ہ کر لیتبد ںیانہ  
 
65. What is page orientation? 
 

Page orientation is the direction in which a document is displayed or printed. There are two types 

of orientation. (1) Portrait and (2) Landscape. 
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  ۔ ںیہ ںیقسمدو  یک شنی نٹ ی اور۔ ےجاتا ہ ایپرنٹ ک  ایکو ظاہر  ومنٹڈاک ںیوہ سمت ہے جس م  یصفحہ کیشن ٹ پیج اورین

(2)   ٹی پورٹر  (1)  اور پیاسک  نڈی ل 

66. Define the Print Preview. 
 

Print preview is a function provided for displaying a page, document or any other material before 

it is sent to a printer. Print preview is a useful function to users as it helps them to see how the 

final printed material will appear. 

سے پہلے ڈسپلے   ےنجیدوسرے مواد کو پرنٹر کو بھ  یکس  ای  ڈاکومنٹصفحہ،  یفنکشن ہے جو کس کیا ویو یپر پرنٹ

مدد   ںیم کھنےی د ہی ںیانھ ہی ونکہ یکفنکشن ہے   دیمف  کیا ےی لکے  ریوز ویو یپرہے۔ پرنٹ جاتا  ایفراہم ک ےیکرنے کے ل

ہوگا۔  ہرظا سےیپرنٹ شدہ مواد ک  یکرتا ہے کہ حتم  

67. What is keyboard shortcut for print command? 
 

CTRL + P is the keyboard shortcut for print command. 

۔ہے  CTRL + P  بورڈ شارٹ کٹ   یک ےیمانڈ کے لپرنٹ ک  
 

69. Why we choose the printer’s name in Print dialog box? 
 

If more than one printer is attached with the computer or network then Name of preferred printer 

must be selected. 

  ہوتا ینتخب کرنا ضرورنام مپرنٹر کا  یحیتو ترج وںسلک ہپرنٹر من ادہیسے ز  کیورک کے ساتھ ا ٹی ن ای  وٹریاگر کمپ 

 ہے۔

70. Define the PDF. 

The Portable Document Format (PDF) is a file format used to present documents in a manner 

independent of application software, hardware, and OS. 

سے سسٹماور آپریٹنگ  ئریہارڈ و  ئر،یسافٹ و شنیکی پلیجو ا ہے ٹیفائل فارم کیا   (PDF)   ٹیفارم ڈاکومنٹ بلیورٹ اپ  

استعمال ہوتا ہے۔ ےیکرنے کے ل شی کو پ ڈاکومنٹ ںیآزادانہ انداز م  
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CHAPTER 4 
 

M i c r o s o f t  E x c e l 
 

Short Questions 
 

1. Define the Spreadsheet program. 
 

A spreadsheet is a software application that enables a user to enter, save, calculate, analyze, sort 

and manage data in arranged form of rows and columns. 

کو داخل  ٹایڈ ںیشدہ شکل م بیترت یکو قطاروں اور کالموں کیوزر ہے جو ئریسافٹ و شنیک  یپلیا کیا ٹیش ڈیاسپر

ہے۔  اقابل بناتکرنے کے  انتظاماور اس کا  نےید بیکرنے، ترت  ہیکرنے، محفوظ کرنے، حساب لگانے، تجز  
 

2. Define the Microsoft Excel 
 

Microsoft Excel is general-purpose electronic spreadsheet software used to organize, sort, 

calculate, and analyze data. 

ساب ح نے،ید بی ترت ے،منظّم کرن کو ٹای ہے جو ڈ ئریسافٹ و ٹی ڈشیاسپر کٹرانکیعام مقصد کا ال کسلیا کروسافٹی مائ

استعمال ہوتا ہے۔ ےی کرنے کے ل ہیور تجزا ےلگان  
 

3. What is use of Microsoft Excel? 
 

The task you can complete with Excel ranges from preparing a simple family budget, preparing a 

purchase order, checking account information, budgets, transactions, billing invoices, creating 3-

D charts, or managing a complex accounting ledger for a medium size business. 

  یک کے آرڈر یداریخرسے لے کر یاریت یبجٹ ک یملیسادہ ف کیوہ ا ںیکے ساتھ آپ جو کام مکمل کر سکتے ہ  کسلیا

، پڑتال جانچ ینوائسز کبلنگ ا ن،ید نیمعلومات، بجٹ، ل یاکاؤنٹ ک ،یاریت    

امتک سب ک  انتظام کرنے کا جریاکاؤنٹنگ ل  دہیچیپ  کیا ےیل   سائز کے کاروبار کے انےیدرم ای  ےچارٹ بنان      3D 

۔یںشامل ہ   

4. What is a workbook? 
 

A workbook is the name given to an Excel file and contains one or more worksheets. Worksheet 

is a single page within that workbook. A workbook contains at least one worksheet. 

اس ورک بک کے اندر  ٹی ورک ش۔ ںیہ یہوت ٹسیورک ش ادہیز ای کیا ںیاور اس م یںہکہتے فائل کو  کسلیاورک بک 

ہے۔ ی ہوت ٹیورک ش کیکم از کم ا ں یورک بک مصفحہ ہے۔  کیا  
 

5. Define the Worksheet. 
 

Worksheet is a working area that consist of rows and columns and is used to enter data. 

استعمال  ےیداخل کرنے کے ل ٹایمشتمل ہوتا ہے اور ڈہے جو قطاروں اور کالموں پر   ایریورکنگ ا کیا ٹیورک ش

 ہوتا ہے۔ 

6. Define the Name box in MS Excel. 
 

The Name Box is the box to the left of the formula bar that displays the cell name that is 

currently selected in the spreadsheet. Usually, a cell name is combination of column name and 

row number. For example, C2 is the cell in Column C and Row 2. 

۔    دکھاتا ہے  ے سیل کا نامیگ   کیے    منتخب   ںی م ٹیڈشیاسپر ے جو  ہخانہ    ایک  طرف  ںیفارمولا بار کے بائ  Name Box   

کا نام کالم کے نام اور قطار نمبر کا مجموعہ ہوتا ہے۔ لیعام طور پر، س  



 
 

 Comp-162   Chapter # 04                                                    14 
 

ہے۔ لیس  C2 C  ںیم 2اور قطار       مثال کے طور پر، کالم 

7. What is Cell Reference? 
 

A cell reference or cell address is a combination of a column letter and a row number that 

identifies a cell on a worksheet. For example, B3 refers to the fifth cell of the second column. 

 

ا  خت کرتشنا یک لیپر س ٹ یہے جو ورک ش  اہوت اور قطار نمبر کا مجموعہ فوحرکالم  ،سیڈریا لیس ای نسریفر لیس

  ہے۔

۔ ہے لیس ںیدوسرے کالم کے پانچوسے مراد    B3   مثال کے طور پر، 
 

8. Define the Formula Bar. 
 

The formula bar is used to create and view formulas. It shows the content or formula stored in 

the active cell. 

   ے ہوےلکھیا اس میں  کے مواد لیس  ایکٹو ہی۔ ےہ یال ہوتاستعم ےیکے ل  کھنےیاور د لکھنےفارمولہ بار فارمولے 

ہے۔  یدکھات ے کوفارمول  

9. Define the Row Headings and Column Headings in MS Excel. 
 

The row headings are the numbers at the left side of the screen that identify each row by number. 

The column heading are the letters across the top of the worksheet grid that identify each column 

by one or more letters. 

۔ کالم ںیکے لحاظ سے شناخت کرتے ہ  مبرن وجو ہر قطار ک ںیہ ہوتے مبرجانب ن ںیکے بائ نیاسکر نگ ی ہیڈقطار ک

حروف سے شناخت  ادہیز ا ی کیکو ا و ہر کالمج ںیموجود حروف ہ ںیحصے م یگرڈ کے اوپر ٹی ش ورک نگ ڈیہ یک

۔ںیکرتے ہ   

10. Define the Cell in MS Excel. 
 

A cell is rectangular box on a spreadsheet where data can be entered. Cells are the intersection of 

columns (labeled as alphabets) and rows (labeled as numbers). A cell is identified by its name 

and every cell has a unique name in a worksheet. 

کے   یکالموں )حروف تہج  لیس جا سکتا ہے۔ ایداخل ک ٹایہے جہاں ڈ ہوتا ہخان ایک شکل کا لیمستط   پر ٹیڈشیاسپر لیس

کے نام سے  سشناخت ا یک لیس ۔ںیشدہ( ملاپ سے بننے ہ  بلیشدہ( اور قطاروں )نمبروں کے طور پر ل بلیطور پر ل

منفرد نام ہوتا ہے۔ کیا ںیم ٹیکا ورک ش لیہے اور ہر س یہوت  
 

11. Define the Active Cell 
 

The active cell is the cell in which text and numbers appear when you type. It is a rectangular 

box highlighting the cell in the sheet. Only one cell can be an active cell at a time. 

 انہخ شکل کا لیمستط  کی ا ہی۔ ںیور نمبر ظاہر ہوتے ہا ٹیکسٹ آپ کے ٹائپ کرنے پر  ں یہے جس م لیوہ س لیس  ایکٹو

ہو سکتا ہے۔  لی س کٹویا کیا لیس کیصرف ا ںیوقت م  کیکرتا ہے۔ ا اںیکو نما لیس ںیم  ٹیہے جو ش  ہوتا  
 

12. Define the Worksheet Tabs 
 

Each worksheet has a tab at the bottom that you can click to display the worksheet. The tabs in 

each new worksheet have standard names (Sheet1, Sheet2, and so on), but you can give your 

own defined names. 

    ی۔ ہر نئںیکلک کر سکتے ہ ےیکرنے کے ل ڈسپلے ٹیہے جسے آپ ورک ش یہوت بیٹ  کیا چےیکے ن ٹیہر ورک ش

(،غیرہو  ,Sheet2, Sheet1    ) ںینام ہوتے ہ یاریکے مع بزیموجود ٹ ںیم ٹیورک ش 
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ھی دے سکتے ہیں۔کے نام ب یضی مرپ اپنآلیکن   

13. How the data can be entered in MS Excel worksheet? 
 

Data can be entered in a worksheet by two ways 
 

Manual: entered by user 
 
Automatic: where data is imported from some other systems or sources, like from 

Access, SQL Server or from web etc. 

جا سکتا ہے۔ ایسے داخل ک قوںی طر کو دو ٹایڈ ںیم  ٹیورک ش  

ہے۔ ایگ ایدرج ک عہیصارف کے ذر: مینول  

 بی و ایسرور  لیا ویک سیا ،ایکسس  سےیجاتا ہے، ج ایذرائع سے درآمد ک ایھ دوسرے سسٹمز چک ٹایڈجہاں  :آٹومیٹک

سے۔ رہیوغ  

14. What type of data can be entered in MS Excel worksheet? 
 

The numbers, text, dates, or times can be entered in a worksheet. 

۔ںیجا سکتے ہ  ےیدرج ک ائمٹ اور یٹ ڈ، کسٹ ٹینمبر،  ںیم  ٹیورک ش  
 

15. How to enter data on a new line within a cell? 
 

To enter data on a new line within a cell, enter a line break by pressing [Alt] + [Enter]. 

۔ںیکرستعمال کا ا کیلائن بردبا کر   [Alt] + [Enter] ے، یے کے لنخل کردا ٹایئن پر ڈلا یکے اندر نئ لیس  
 
 

16. Define the formulas in MS Excel Sheets. 
 

Formula is an expression which calculates the value of a cell. A formula always starts 

with an equal sign (=). 
 

For example, the following formula adds up the values in cells A2 and B2. 

       =A2+B2 

 شہیفارمولا ہم  کیقدر کا حساب لگاتا ہے۔ ا یک لیہے جو سایکسپریشن  کیفارمولا ا
نشان )=( سے شروع ہوتا ہے۔  یساوم  

A2 اور B2  تا ہے۔مع کرقدروں کو ج ںیم لز یس فارمولہ لیکے طور پر، درج ذ مثال  

       =A2+B2 
17. Define the functions. 
 

Functions are predefined formulas that can be a more efficient way of performing mathematical 

operations than formulas. 

  ادہیزکا  نےیکو انجام د  شنزیآپر یاتیاضیرو فارمولوں کے مقابلے ج ںیہ ہوتے فارمولےشدہ  تیارفنکشنز پہلے سے 

ہو سکتا ہے۔ قہیموثر طر  
 

20.What is the difference between formula and function? 
 

A function is predefined formula that cannot be changed and on the other hand formula is user 

defined expression that has flexibility to be changed. 

شدہ   تیار اکیوزرطرف فارمولہ  یتا اور دوسرجاسک  ایک  ںینہ لیہے جسے تبد ہوتا فارمولہ شدہ تیارفنکشن پہلے سے 

ہے۔  یہوت گنجائش یک یلیتبد ںیہے جس م  ہوتا ایکسپریشن  

23.Define the cell range. 
 

In a spreadsheet a cell range is a collection of selected cells.  

ے کو کہتے ہیں۔مجموع ےک لزیمنتخب س نجیر لیس ںیم  ٹیڈشیاسپر  
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25. Define the cell formatting. 
 

Formatting of cells in Excel means, you can change the appearance of text in a cell without 

changing the text itself. You can apply a number format (0.8, $0.80, 80%, etc) or other 

formatting (alignment, font, border, etc). 

شکل کو   یظاہر یک کسٹی ٹ ںیم لیس  ریغب  ےیک لیکو تبد کسٹیٹ آپ ہککا مطلب ہے  ٹنگیفارم یک لزیس ںیم کسلیا

 و( کرہیوغ فونٹ، بارڈر، دھ،ی)س ٹنگی فارم گرید ای( رہی، وغ80%، $0.80، 0.8) ٹینمبر فارم آپ۔ ںیکر سکتے ہ لیتبد

۔ںیکر سکتے ہ یئپلاا  

29. What is data alignment? How can we change it in a cell? 
 

Data alignment means adjusting the data position in a cell. For this purpose, we can use 

alignment settings in “Home tab”. We can set both horizontal and vertical alignment. 

منٹ  ن ئالا ںیم  بیہم ہوم ٹ ےیہے۔ اس مقصد کے ل کرنا ڈجسٹیکو ا شنیپوز کی ٹایڈ ں یم لیالائنمنٹ کا مطلب س ٹایڈ

۔ں یسکتے ہ کر  ٹیس الائنمنٹ یہ  دونوں یاور عمود ی افق ہم۔ ںی استعمال کر سکتے ہ زکانگ ٹیس  
 

30. Where the new inserted column is positioned? 
 

When you insert a new column, the new column will be positioned on the left of the column 

containing the active cell. 

۔ گاہو  لیس کٹویا ںیگا جس م  بنےجانب  ںیکے بائکالم  اس کالم ایتو ن ،ںیہکالم داخل کرتے  نیا کیجب آپ ا  
   

33. What is chart? 
 

A chart is a powerful tool that you can use to visually display data in a variety of different chart 

formats such as Bar, Column, Pie, Line etc. Excel provides an easy way to create chart. 

ول ژ یو کو ٹایڈ ںیم رہیلائن وغ ،یبار، کالم، پائ سےیج ٹس یفارم چارٹ جسے آپ مختلفطاقتور ٹول ہے  کیچارٹ ا 

تا ہے۔فراہم کر قہیآسان طر کیچارٹ بنانے کا ا کسلی۔ اسکتے ہیں کراستعمال  ےیکے لکرنے ظاہر انداز  
 
34. What are the elements of a chart?  

Following are the elements of a chart 

۔ ںیہ لیچارٹ کے عناصر درج ذ  

▪ Chart Title 

▪ Data Labels 

▪ Legend 

▪ Grid lines 

▪ Axis  

▪ Axis Titles 

35. What are types of charts in MS Excel?  

Following are the types of charts used in MS Excel 

۔ ںیہ لیسام درج ذاق ینے والے چارٹس کہو استعمال ںیم کسلیا سیا میا   
▪ Column Charts 
 
▪ Bar Charts 
 
▪ Line Charts 
 
▪ Pie Charts 
 
▪ Area Charts 
 
▪ Scatter Charts 
 
▪ Other Charts 
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36. Define the Column Charts. 
 

A column chart displays each data point as a vertical column. The height of the column 

corresponds to the data value.  

۔ہے یہوت  طابقکے م  ویلیو ٹایڈ یاونچائ یکالم ک ۔کالم کے طور پر دکھاتا ہے یپوائنٹ کو عمود ٹایم چارٹ ہر ڈکال  
 

37. Define the Bar Charts. 
 

A bar chart displays each data point as a horizontal bar. The length of the bar corresponds to the 

data value. One distinct advantage to use a bar chart is that the category labels may be easier to 

read. 

ارٹ ۔ بار چہے۔ یمطابق ہوتکے  ویلیو  ٹایڈ یلمبائ یبار کے طور پر دکھاتا ہے۔ بار ک یپوائنٹ کو افق  ٹایبار چارٹ ہر ڈ

تا ہے۔وو پڑھنا آسان ہک بلزیکے لگری کیٹ  ںاس می ہے کہ ہیفائدہ  اور کی ا اکرنے استعمال ک  
 

38. Define the Line Charts. 
 

Line chart displays data values as equally spaced points connected with a line. It is often used to 

plot data that changes continuously over time. This chart useful for identifying trends over time. 

اس کا  والے پوائنٹس کے طور پر دکھاتا ہے  ےفاصل کساںیلائن کے ساتھ منسلک  کیکو ا  زویلیو یک ٹایلائن چارٹ ڈ

 چارٹ وقت کے ہی ۔وہ ارہت اجاتا ہے جو وقت کے ساتھ مسلسل بدلت ایک  ےیکرنے کے ل اہرظکو  ٹایڈ سےیاستعمال اکثر ا

ہے۔  دیمف ےیل  شناخت کے یک رجحانات ھسات  
 

39. Define the Pie Chart. 
 

A pie chart is a circular chart divided into different sectors; each sector shows the relative size of 

each data value.  

ے  ک وی لیو ٹایڈہر  سائزے کا صحہر  ہے۔ ہوتا  ایگ ایک میتقس ںیم وںحص ختلفمہے جسےسرکلر چارٹ  کیارٹ اچ یپائ

ہے۔  یا جاتادکھا مطابق   
 

40. Define the Area Charts. 
 

Area charts are similar to line charts except that the area underneath the line filled with color. 

ا ہوتا  رنگ سے بھرا ہو ہقعلا کا چےیے کہ لائن کے ن سوائے اس ک ںیہوتے ہ ہی رحط  یچارٹس لائن چارٹس ک ایریا

۔ہے  

41. What is keyboard shortcut to get hard copy of worksheet?  

Ctrl + P is the keyboard shortcut to get hard copy of worksheet. 

۔ہے  Ctrl + P  بورڈ شارٹ کٹ   یک ےیل حاصل کرنے کے یہارڈ کاپ ی ک ٹیورک ش  
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  CHAPTER 5 

M i c r o s o f t  P o w e r P o i n t 

EXERCISE 
 

Short Questions 
 

Q: What is Power point? 

PowerPoint is a presentation software developed by Microsoft. It is used to display information 

in the form of a slide show. 

۔ہے ایک  ارینے ت  Microsoft    ہے جسے رئیٹ وساف شنیزنٹیپر کیپاورپوائنٹ ا

استعمال ہوتا ہے۔   ےیمعلومات کو ظاہر کرنے کے ل ںیشکل م یشو ک ڈیسلائ ہی  
 

Q: What is a presentation? 

A presentation is the process of communicating a topic from a speaker to an audience. 

۔ےل ہموضوع کو پہنچانے کا عم یتک کس نیمقرر سے سامع یکس شنیزنٹ یپر  

Q: Write two names of programs used for making presentations other than MS Power 

Point. 

1. Prezi 

2. Zoho Show 

3. Google Slides    
Q: What is a slide? 

A slide is a single page of a presentation. 

۔ے کو کہتے ہیںصفح کی ا ےک شنیزنٹیپر ڈیسلائ  

Q: What is slide pane? 

Slide pane is that section of Power Point window which contains the current slide of your 

presentation. 
ہے۔  یہوت ڈیموجودہ سلائ  یک  شنیزنٹیپر یآپ ک ںیپاور پوائنٹ ونڈو کا وہ حصہ ہے جس م نیپ  ڈیسلائ  

Q: What is meant by slide layout? 

A slide layout is like a slide template that contains formatting, positioning, and placeholders for 

all of the content that appears on a slide. 

  ٹنگ،یفارم ےیپر ظاہر ہونے والے تمام مواد کے ل ڈیسلائ ںیطرح ہوتا ہے جس م  یک ٹیمپل یٹ ڈیسلائ  کیآؤٹ الے ڈیسلائ
۔ ںیہولڈرز ہوتے ہ سیاور پل شننگیپوز  

Q: What is place holder in Power Point? 

A placeholder is a pre-formatted container/box on a slide for content. 

باکس ہوتا ہے۔/نریشدہ کنٹ  ٹیپر پہلے سے فارم ڈی سلائ  ےیہولڈر مواد کے ل سیپل  
Q: What is meant by title slide? 

It is the first slide in the slide deck. By default, in PowerPoint, the title slide offers two text boxes 

for a title and subtitle. 

دو  ےیٹائٹل اور سب ٹائٹل کے ل ںیم ڈیٹائٹل سلائ  کی، پاورپوائنٹ  ڈیفالٹ یئ ابہے۔  ہوتی ڈیسلائ یپہل ںیم  کیڈ ڈیسلائ ہی
۔تے ہیںوہبکس  کسٹیٹ  

Q: Write short cut key to start slide show from 1st slide and current active slide. 

To start a presentation from the beginning.             F5 

To start a presentation from the current slide. Shift+F5 

F5 ہے۔   ے یشروع کرنے کے ل شنیزنٹ یشروع سے پر  کی شارٹ کٹ  
Shift+F5 ۔ہے      کی شارٹ کٹ ےیشروع کرنے کے ل شنی زنٹیرے پس ڈی موجودہ سلائ

Q: What is meant by slide transition? 

A slide transition a visual effect that occurs when one slide is removed from the screen and the 

next slide is displayed during a presentation. 
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 نیاسکر وک ڈیسلائ کیا کے دوران شنیزنٹ یپر ہوتا ہے جب ظاہر جو اس وقتہے   یفیکٹا ولژ یو کیا شنیٹرانز ڈیسلائ
ہے۔  کیا جا تاظاہر کو   ڈیسلائ یہے اور اگل  اجاتیا سے ہٹا  

Q: What is meant by slide animation? 

Animations are visual effects for the individual objects that make slide objects move on a slide ۔ 

  حرکتپر  ڈیکو سلائ سکٹی آبج ےک  ڈیجو سلائ  ںیہ و تےہ  کٹیف یا ژولیو ےیکے ل  سکٹیآبج یانفراد ےک ڈیسلائشنزیم ینیا
۔ ںیتے ہ وارک  

Q: How a new slide can be inserted in a presentation? 

On the Home tab, click New Slide button.     Or  Press Ctrl + M 

۔ںیدبائ  Ctrl + M     یا ۔ںیبٹن پر کلک کر ڈیسلائ  وی، نمیں بی ٹ ہوم

Q: What is meant by slide show in power point? 

 A slide show is a series of slides, often displayed on a large screen using a video projector. 

  ایپر دکھا نیاسکر یبڑ کی کرتے ہوئے ا مالکا استع  کٹری پروج  ویڈیسلسلہ ہے، جو اکثر و کیکا ا ڈوںیشو سلائ  ڈیسلائ
 جاتا ہے۔

Q: Which keys of keyboard are used to run the slide show from start toward end? 

OR 

Q: Which keys of keyboard are used to go to the next slide? 

Enter, Spacebar, Right arrow key, Page down and N  

Q: For which purpose, the slide sorter option is used in power point. 

It shows a miniature of each slide. It is used to rearrange and hide slides. 

استعمال ہوتا   ےیاور چھپانے کے ل نےید بی کو دوبارہ ترت ڈوںیسلائ  ہیشکل دکھاتا ہے۔  یچھوٹ کیا یک ڈیہر سلائ ہی
 ہے۔

Q: How a slide show is terminated? 

By pressing the Esc key at keyboard. 

Esc کو دبانے سے۔ یک  سے بورڈ  یک    

Q: What is meant by template in power point? 

A PowerPoint template is a pattern of a slide or group of slides that you save as a .potx file. 

Templates can contain layouts, colors, fonts, effects, background styles, and even content. 

 

۔ںیمحفوظ کرتے ہپر طورفائل کے  .potx    ےہ کے گروپ کا نمونہ ڈوںیسلائ ای ڈیسلائ  کیا ٹیمپل یپاورپوائنٹ ٹ  آپجسے
ہوسکتا ہے۔  شامل یتک کہ مواد بھ ہاںیاور  ں،یطرز ی، پس منظر کیفیکٹسرنگ، فونٹ، ا ،بی ترت ںیم  ٹسیمپلیٹ
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CHAPTER 6 

Programming Language 
 

EXERCISE 
 

Short Questions 
 
 

Q #2What is the basic data types associated with C? 
 

Answer: 
 

 Int – Represent the number (integer) 
 

 Float – Number with a fraction part. 
 

 Double – Double-precision floating-point value 
 

 Char – Single character 
 

 Void – Special purpose type without any value. 
 

Q #3What is the description for syntax errors? 
 

Answer: The mistakes/errors that occur while creating a program are called syntax errors.  
 
Q #4What is the process to create increment and decrement statement in C? Answer: 

There are two possible methods to perform this task. 
 
Use increment (++) and decrement (-) operator. 
 

Use conventional + or – sign. 
 

Example When x=4, use x+1 to get 5 and x-1 to get 3. 
 

Q #5 What is reserved words with a programming language? 
 

Answer: The words that are a part of the standard C language library are called reserved 

words. Those reserved words have special meaning. 

Example: void, return int. 
 

Q #6 What is the difference between ++a and a++? 
 

Answer: ‘++a” is called prefixed increment and the increment will happen first on a 

variable. ‘a++’ is called postfix increment and the increment happens after the value of a 

variable used for the operations. 
 

Q #7 Describe the difference between = and == symbols in C 

programming? 
 

Answer: ‘==’ is the comparison operator which is used to compare the value or 

expression on the left-hand side with the value or expression on the right-hand side. 
 

‘=’ is the assignment operator which is used to assign the value of the right-

hand side to the variable on the left-hand side. 
 

Q #8What is the general description for loop statements and available loop 

types in C? 
 

Answer: A statement that allows the execution of statements or groups of statements in a 

repeated way is defined as a loop. 
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There are 4 types of loop statements in C. 
 

 While loop 
 

 For Loop 
 

 Do…While Loop 
 

 Nested Loop 
 

Q #9 What is a nested loop? 
 

Answer: A loop that runs within another loop is referred to as a nested loop. 

The first loop is called the Outer Loop and the inside loop is called the Inner 

Loop.  

Q#11 Define an algorithm. 
 

Answer: An algorithm is a precise specification of a sequence of instructions to be 

carried out in order to solve a given problem.  
 

Q#12What is the difference between while and do-while statement? 
 

Answer: While statement evaluates its condition at the top of the loop; whereas the do-

while evaluates its condition at the bottom of the loop. 

Q#15 Compare and contrast compilers from interpreters. 
 

Answer: Interpreters execute program codes one line at a time, while compilers take the 

program as a whole and convert it into object code, before executing it.  

Q#17What are header files and what are its uses in C programming? 

 Answer: Header files are also known as library files. Each header file contains a set of 

functions. For example: stdio.h is a header file. 

Q#18What is syntax error? 

Answer: A syntax error is an error in the source code of a program. Any part of the code 

that do not follow to the syntax of the programming language will produce a syntax error. 

Q#19 What are variables and in which way is it different from constants? 

Variables are the terms which can change or vary over time. It does not remain constant, 

unlike constant. 
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CHAPTER 7 
 

    INTERNET & EMAIL 
 

EXERCISE 
 

Short Questions 
 

Q: What is internet? 

The Internet is a vast network that connects computers all over the world. 

کو جوڑتا ہے۔  وٹرز ی کے کمپ ایدن یورک ہے جو پور ٹین  عیوس کیا ٹی انٹرن  
 
Q: What is intranet? 

An intranet, is a local or restricted network that enables people to store, organize, and share 

information within an organization. 

کرنے، منظم   سٹورکے اندر معلومات کو  شنیآرگنائز یورک ہے جو لوگوں کو کس  ٹی محدود ن  ای وکلل کیا ٹ،یانٹران
کرنے کے قابل بناتا ہے۔  ئریکرنے اور ش  

 
Q: Which medium are used to connect the computers with each other? 

Telephone lines, twisted pair cable, Fiber optical cable, Satellite, etc. 

۔رہیوغ ٹلائٹ،ی س بل،یک کلیفائبر آپٹ ، بلی ک ئریپ  ڈٹو سٹ فون لائنز، یلیٹ  

Q: Which software is used to transfer data on internet from one computer to another 

computer? 

FTP (File Transfer Protocol) 

(FTP) پروٹوکول فرفائل ٹرانس  

Q: What is internet server? 

A server is a computer that serves information to other computers. 

کو معلومات فراہم کرتا ہے۔  وٹرزیہے جو دوسرے کمپ  ہوتاوٹر یکمپ  سایا کیسرور ا  

Q: What is WWW and for what it stands? 

World Wide Web 
 
Q: What is web page? 

A web page or webpage is a document, commonly written in HTML, that is viewed in an 

Internet browser. 
HTML جاتا ہے۔ کھای د ںی براؤزر م ٹی جسے انٹرن   اورہے اجات  الکھ ںی م  پرطورعام  جو  ہے ہوتا ایسا ڈاکومنٹ  کی ا پیج ب ی و   

 
Q: Define website. 

A website is a collection of linked web pages that is identified by a single unique domain name 

ہے۔  ینام سے ہوت کے نیڈوم  منفرد ہی کیشناخت ا یجس کہے ہوتا  کا مجموعہ زپیج  بیو ڈسائٹ لنک  بیو  
 
Q: For what ISP stands? 

ISP stands for Internet Service Provider. 
 
Q: What is web browser? 

A web browser is a software used to access and view websites on the internet. Common web 

browsers include Microsoft Internet Explorer, Google Chrome, Mozilla Firefox, and Apple 

Safari. 

  ےیکے ل  کھنےید ںیحاصل کر نے اور انہ یسائٹس تک رسائ بیپر و ٹی ہے جو انٹرن ئری فٹ وسا سایا کیبراؤزرا بیو
ںیبراؤزرز م بیاستعمال ہوتا ہے۔ عام و  

۔ںیشامل ہ   Mozilla Firefoxاور ،  Apple Safari, Google Chrome, Microsoft Internet Explorer 
 
Q: Define search engine. 

A search engine is a website through which users can search internet content. 
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۔ ںیمواد تلاش کر سکتے ہ ٹی انٹرن یوزر عےیسائٹ ہے جس کے ذر بیو کیسرچ انجن ا  

Q: What is modem? 

Modem is short for "Modulator-Demodulator." It is a hardware component that allows a 

computer to connect to the Internet. 

سے  ٹیکو انٹرن  وٹریجو کمپ  کا جزو ہے ئریہارڈ و کیا ہی ہے۔ ففمخ اک  "Modulator-demodulator" میموڈ  
تا ہے۔کر  کونیکٹ   

Q: What is URL? 

URL stands for Uniform Resource Locator, and is the address of a web page. 

۔ہے اڈریس ہوتاکا  پیج  بیو کسی ہیہے، اور  ٹریلوک  سورسیر فارمیونیکا مطلب   URL 

Q: What is an email? 

Email, short for "electronic mail". It allows you to send and receive messages to and from 

anyone with an email address, anywhere in the world. 

  یکو بھ یکس یبھ ںیکہ ںی م ایدن  کے ساتھ سیڈریا لیم یا آپ عےیذر اس کے۔فف ہےمخ ا" کلیم  کٹرانکی"ال ل،یم یا
ہیں ۔ ےسکتاور وصول کر سکتے ہیں جیبھ غاماتیپ  

 

Q: What is meant by home page? 

A home page is the main web page or introductory page of a website. 

ہوتا ہے۔ پیج یتعارف ای پیج بیو یسائٹ کا مرکز بی و یکس جیہوم پ  

Q: Write two advantages of email. 

Email is a free tool. 

Email is quick. ... 

Email is accessible from anywhere. 

ٹول ہے۔  فری کیا لیم یا  

ہے۔ زیت لیم یا   

ہے۔ یقابل رسائ یسے بھ ںیکہ لیم یا  

Q: Write names of three email service provider companies. 

 1. Gmail 

 2. Yahoo Mail 

 3. Outlook 
 
Q: Write name of four search engines. 

1. Google Search 

2. Ask.com 

3. Yahoo! Search 

4. Lycos 

Q: What is meant by "Sign in" with respect to email? 

Entering username and password to open email account. 

۔ہلا تا ہےک  Sign in    نام اور پاس ورڈ درج کرنا یوزر کا ےی اکاؤنٹ کھولنے کے ل لیم یا 
 
Q: What is meant by cloud storage? 

Cloud storage offers a simple way to save data securely online so that it can be accessed anytime 

from any location. Examples of Cloud Storage are Google Docs, Xdrive, etc. 

جگہ  یبھ یکرتا ہے تاکہ کس فراہم قہیآسان طر کیکرنے کا ا سٹورسے آن لائن  قےیو محفوظ طرک ٹایڈ جیکلاؤڈ اسٹور
جا سکے۔ یحاصل ک یتک رسائ ٹایڈ وقت اس یبھ یسے کس  

۔ںیہ رہیوغ  Google Docs  ،Xdrive ںیمثال یک جیکلاؤڈ اسٹور   
 
Q: What is meant by uploading and downloading? 

Uploading means data is being sent from your computer to the Internet. 

Downloading means your computer is receiving data from the Internet. 

جا رہا ہے۔ جایپر بھ ٹی سے انٹرن  وٹریآپ کے کمپ ٹایاپ لوڈ کرنے کا مطلب ہے کہ ڈ  

ل کر رہا ہے۔حاص ٹایسے ڈ  ٹیانٹرن  وٹریلوڈ کرنے کا مطلب ہے کہ آپ کا کمپ ڈاؤن  
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Q: What is "Inbox" in email? 

An electronic folder in which emails received by an individual are held. 

۔ ںیہ یجات یرکھ لزیم یا یفرد کو موصول ہونے وال یکس ںیفولڈر جس م کٹرانکیال کیا  
 
Q: For what HTTP stands for? 

Hypertext Transfer Protocol. 
 
Q: What is difference between intranet and extranet? 

An intranet is a private network, operated by a large company. Whereas an extranet is an intranet 

that is accessible to some people from outside the company. 

  یہے جو کمپن ٹیانٹران کی ا ٹیکسٹرانیہے۔ جبکہ ا یلاتچ یکمپن یبڑ کیورک ہے، جسے ا ٹین ینج  کیا ٹیانٹران
ہے۔  یقابل رسائ بھیےیسے باہر کے کچھ لوگوں کے ل   

 
Q: What is a host computer? 

A computer or server connected to a network and providing facilities to other computers. 

فراہم کرتا ہے۔ اتیکو سہول  وٹرزیاور دوسرے کمپ  وہورک سے جڑا ہوا   ٹیسرور جو ن ای  وٹریکمپ  کیا  

Q: What is google? 

Google is a search engine. 

سرچ انجن ہے۔ کیگوگل ا  

Q: What is meant by CC and BCC in email? 

CC stands for Carbon Copy, while the BCC field stands for Blind Carbon Copy. 

BCC  ہے۔  یاپکا مطلب بلائنڈ کاربن ک    CC لڈیف جبکہ ہے، یکا مطلب کاربن کاپ 


